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1 Einleitung

1 Einleitung

1.1 Was ist Aspect?

Da jede Montierung einen mehr oder weniger großen Periodischen Fehler aufweist gilt es
diesen zu eliminieren.
Dazu gibt es die sogenannte PEC-Tabelle (Periodic Error Correction) in welcher grob
gesagt drin steht wann die Montierung schneller und wann langsamer laufen soll um
eben diesen Fehler auszugleichen.
Normalerweise wird das von Hand gemacht. Dazu nimmt man ein Fadenkreuzokular
startet die PEC-Aufzeichnung und steuert mit der Handbox die Montierung so, dass der
anvisierte Stern stets in der Mitte verharrt.

Aspect ist ein Programm, welches diesen Prozess automatisieren und vereinfachen soll!

1.2 Was wird benötigt?

An Hardware braucht man:

• eine Montierung mit einer Littelfoot-Steuerung, der Littelfoot Vpower oder mit
dem Update-Kit von Anand Rajiva

• eine Webcam

• ein Computer

• und die entsprechenden Kabel

und an Software:

• V4 Control von Douglas Dieter

• und natürlich Aspect von Wolfgang Hoffmann

Achtung:
Diese Anleitung wurde für Aspect 0.9 und Firmware V4 geschrieben!
Theoretisch unterstützt Aspect 0.9 auch die Firmware Version 3.59.
Da aber ein Downgrade von V4 auf V3.xx nicht möglich ist konnte dies nicht
mehr getestet werden!
Die letzte mit Firmware V3.59 getestete Version ist Aspect 0.7 welche aber
Firmware V4 noch nicht unterstützt.
Da es aber auch in Bezug auf das Erstellen einer PEC Tabelle viele Verbesse-
rungen in V4 gab wird ein Upgrade auf V4 empfohlen!
Das erstellen einer PEC-Tabelle mit einer älteren Aspect Version unterscheidet
sich im Vorgehen aber kaum.
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1 Einleitung

1.3 Installation

1.3.1 V4 Control

Nach dem das Programm von oben genannter Seite heruntergeladen worden ist (alter-
nativ direkt hier) entpackt man die Datei in einen beliebigen Ordner (welcher nach der
Installation wieder gelöscht werden kann), führt das Setup (doppelklick auf Setup.exe)
aus und folgt einfach den Installationsanweisungen. Falls es eine Warnung ”Version Con-
flict“ gibt, sollte man die neueren Dateien beibehalten.

Da es für das Programm eine eigene Dokumentation in Deutsch und Englisch gibt wird
an dieser Stelle nicht Näher auf das Programm eingegangen sondern nur die wichtigsten
Dinge in Bezug auf Aspect erklärt.

1.3.2 Aspect

Für Aspect gibt es kein Setup welches man einfach ausführen kann - die Installation ist
aber denkbar einfach: Zuerst läd man sich die benötigten Dateien runter das sind in der
Regel

• aspect.exe - das eigentliche Programm

• und die benötigten Bibliotheken

– QtCore4.dll

– QTGui4.dll

– mingwm10.dll

Dann erstellt man sich einen neuen Ordner (z.B. C:\Programme\Aspect) und kopiert
alle Dateien in diesen Ordner - das wars schon!
Alternativ kann natürlich noch eine Verknüpfung ins Startmenü oder auf den Desktop
erstellt werden

Erhält man beim Starten von Aspect eine der folgenden Fehlermeldungen

hat man vergessen die 3 Bibliotheken in das Verzeichnis zu kopieren!
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2 PEC-Tabelle erstellen

2 PEC-Tabelle erstellen

Das erstellen einer PEC-Tabelle gliedert sich in 3 Schritte:

1. Periodischen Fehler aufzeichnen (V4 Control)

2. Erstellen und Bearbeiten der Tabelle (Aspect)

3. Tabelle in die Steuerung laden (Aspect oder V4 Control)

2.1 Periodischen Fehler aufzeichnen (V4 Control)

2.1.1 Vorbereitung

Für das erfolgreiche Erstellen einer PEC-Tabelle ist es sehr wichtig, dass die Montierung
sauber eingenordet ist!
Aspect hat zwar die Möglichkeit einen eventuell auftretenden Drift rauszurechnen aber
falls die Montierung einen recht großen Periodischen Fehler aufweißt und dazu noch ein
Drift vorhanden ist, kann es zu Problemen beim Aufzeichnen des Periodischen Fehlers
kommen.

Wir norden also die Montierung sauber ein und zentrieren einen hellen Stern nahe des
Himmelsäquator und setzen die Webcam anstelle des Okulars ein.
Dann starten wir V4 Control und verbinden zur Steuerung (Connect) - war das Erfolg-
reich können wir oben auf Webcam klicken:

Achtung: zuerst eine Verbin-
dung zur Steuerung herstellen
und dann erst das Webcam-
Fenster öffnen - sonst kann der
Periodische Fehler nicht aufge-
zeichnet werden!

Dann richten wir unter Video ⇒
Format bzw. Source die Webcam
so ein, dass der Stern Möglichst
klein ist also eventuell die Belich-
tung runter und gut Fokussieren.
Es sollte dann ungefähr so ausse-
hen wie links.

2.1.2 Einstellungen

Ist das Geschafft können die restlichen Einstellungen gemacht werden.
Dazu öffnen wir das Fenster Options und stellen die Webcam- und Teleskopparameter
ein:

Aspect - A Simple PEC Tool 4



2 PEC-Tabelle erstellen

Die für unser Vorhaben wichtigen Einstellungen
sind:

• Guide Scope Focal Length:
Brennweite des Teleskops

• CCD X/Y axis Pixel Size:
Größe eines Pixels der Kamera in µm

• Search Box :
Größe des Suchfensters

• Pec Log File Name:
Name der Log-Datei

Was bedeuten nun die einzelnen Einstellungen?

• Brennweite des Teleskops:
Sollte eigentlich klar sein!
Man sollte allerdings beachten, dass es bei einem großen Periodischen Fehlers und
einer großen Brennweite (plus eventuellem Drift durch Aufstellungsfehler) dazu-
kommen kann, dass der Stern aus dem Suchfenster wandert!
In diesem Fall sollte man entweder den Wert für das Suchfenster erhöhen oder
falls das nicht mehr Möglich ist einen Brennweitenreduzierer bzw. ein Teleskop
mit geringerer Brennweite benutzen.

• Pixel Größe:
Auch hier gibt es nicht viel zu sagen für die Philips ToUcam Pro z.B wären das
5.6 x 5.6µm

• Suchfenster:
Das Suchfenster kann man sich wie einen Kasten um den Stern vorstellen in dem
die Sternposition ausgewertet und der daraus resultierende Fehler berechnet wird.
Man sollte das Fenster so klein wie Möglich halten, denn je größer das Fenster
desto größer wird die benötigte Rechenleistung. Wandert der Stern allerdings aus
dem Fenster raus, kann der Fehler nicht mehr Korrekt gespeichert werden.
Die Breite des Fensters (enspricht der RA-Bewegung) ist fest auf 100 Bogense-
kunden eingestellt man ändert also nur die Höhe. Bei einer sauber eingeordneten
Montierung kann der Wert also ruhig klein gehalten werden!

Hinweis:
In der aktuellen V4 Control 1.0.2 (Beta) gibt es eine zusätzliche Einstellung
Max PE hiermit kann die Breite des Suchfensters in Bogensekunden eingestellt
werden!
Kennt man aus vorangegangenen Messungen den Periodischen Fehler der Mon-
tierung kann nun die Breite des Suchfensters optimal eingestellt werden.
Erwartet man z.B. einen PE von 20“ kann der Max PE-Wert auf 50-60“ ein-
gestellt werden.

• Pec Log File Name:
Das ist der Name des Logfiles welches nachher in Aspect eingelesen wird.
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2 PEC-Tabelle erstellen

Der Name sollte aussagekräftig sein also vielleicht Datum und Name des verwen-
deten Sterns, damit man später die Logdatei zuordnen kann und die Deklination
des Sterns in Aspect eintragen kann.
Die Logdatei wird im Hauptordner von V4 Control erstellt.

Achtung: Wenn man den Namen für eine neue Messung nicht ändert wird die
neue Messung an das Ende der alten Messung (falls vorhanden) angehängt. Es
ist dann zwar nichts verloren man müsste dann aber entweder die alten Werte
von Hand aus der Tabelle löschen bzw. in eine neue Datei kopieren oder die Ta-
belle nachher in Aspect ”beschneiden“ lassen was mit unnötigem Arbeitsaufwand
verbunden ist!

2.1.3 Starten der Aufzeichnung

Nach dem alles eingestellt wur-
de klicken wir auf Lock und das
Fenster ändert sich.
Unter View kann man noch ein
Fadenkreuz und einen Kreis (der
Durchmesser wird unter Options
⇒ Circle Diameter eingestellt)
ein/ausblenden.
Dann müssen wir dem Programm
noch sagen welchen Stern wir ver-
wenden wollen.
Dazu klicken wir einfach auf den
Stern - das Fadenkreuz sollte nun
auf unseren Stern springen.
Setzen wir noch den Hacken bei
Follow Star wandert das Faden-
kreuz mit dem Stern mit.
Mit dem Schieber neben Preview können wir einstellen in welchen Abständen wir ein
neues Bild schießen wollen - was auch die Anzahl der Messwerte beeinflusst.
Hier sollte man je nach Rechenleistung ein wenig rumprobieren.
Mehr Bilder pro Sekunde liefert uns nachher eine glattere Kurve erhöht aber die Re-
chenleistung.

Als letztes sollten wir V4 Control noch beibringen wie schief unsere Kamera sitzt dazu
klicken wir einfach auf Calibrate - eventuell vorher die ”Guide Rate“ kleiner als 2x wäh-
len, falls der Stern rauswandert.
Jetzt wird vom Programm die Sternbewegung analysiert und daraus der Winkel der Ka-
mera und die O/W bzw. N/S Richtung bestimmt (wichtig wenn z.B. ein Zenitspiegel
verwendet wird oder das Webcam-Bild gespiegelt wurde).
Falls der Winkel größer als 15◦ ist sollte man die Kamera so drehen, dass der Winkel
kleiner wird!

Hinweis:
Ist die Schaltfläche Calibrate grau hinterlegt, hat man vergessen den Haken bei
Follow Star zu setzten!

War das Erfolgreich sollte sich das Fadenkreuz um den eben bestimmten Winkel drehen.
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2 PEC-Tabelle erstellen

Dann können wir endlich mit dem eigentlichen Loggen anfangen:

Wichtig:
Wollen wir zum ersten mal eine PEC-Tabelle erstellen (oder eine neue) muss
PEC vorher deaktiviert werden, weil wir sonst ja den schon korrigierten PE
aufzeichnen (das kann man machen wenn man die Tabelle verfeinern will siehe
Abschnitt 3).
Desweiteren sollte auch Intelly TrackR© deaktiviert sein

Also Stern nochmals zentrieren bzw. neu auswählen falls er beim kalibrieren verloren
gegangen ist und dann entweder mit File ⇒ Log Errors oder mit dem Tastaturküzel
Strg+L die Aufzeichnung beginnen.

Das Fadenkreuz bleibt dann ste-
hen und es erscheint ein grünes
Rechteck, welches das Suchfens-
ter darstellen soll.
Nun sollte man mindestens eine
komplette Umdrehung der Schne-
cke aufzeichnen lassen - besser
sind zwei Umdrehungen (bei der
EQ6 wären das 8-16min)!
Ist der Stern die ganze Zeit inner-
halb des grünen Rechtecks geblie-
ben können wir die Aufzeichnung
wieder stoppen (mit File ⇒ Log
Errors oder Strg+L) und wir ha-
ben es geschafft!
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2 PEC-Tabelle erstellen

2.2 Erstellen und Bearbeiten der Tabelle (Aspect)

2.2.1 Einführung in Aspect

In diesem Abschnitt findet man einen kurzen Überblick über die Funktionen von Aspect.
Wer mehr auf Praxis steht kann ruhig in Abschnitt 2.2.2 weiterlesen.

Starten wir also Aspect - klappt das nicht sollte man in Abschnitt 1.3.2 nochmal nach-
lesen.

Wie man sieht ist Aspect in zwei Bereiche aufgeteilt im linken Bereich werden alle Ein-
stellungen getätigt und der rechte Bereich dient zur Visualisierung der Daten.
Es ist aber auch Möglich die Bereiche zu vergrößern/verkleinern falls man z.B. eine grö-
ßere Darstellung der Graphen wünscht. Dazu einfach die Mitte der beiden Bereichen
nach rechts oder links schieben.

Schauen wir uns den linken Bereich etwas genauer an:
Dieser besteht aus drei Reitern, welche die drei Schritte widerspiegeln um aus einem
PE-Logfile eine PEC-Tabelle zu erzeugen.

Der erste Reiter (MCU) ist für Einstellungen rund um die Steuerung gedacht um nacher
verschiedene Daten aus der Steuerung zu lesen und um die erstellte Tabelle in die Steue-
rung zu laden:

• Littelfoot/MCU Connection:
Hier wird bei Serial Port der COM-Port eingestellt an dem die Steuerung mit dem
Computer verbunden ist.

• Settings:
Hier kann durch klicken auf Refresh erstmal geprüft werden ob die Kommunikation
klappt und dann (falls gewünscht) die Nachführung (Tracking) geändert, oder PEC
bzw. Intelly Track R© de/aktiviert werden.

Aspect - A Simple PEC Tool 8
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Der zweite Reiter (PE Data) widmet sich der Berarbeitung des PE-Logfiles:

• PE Measurement:

· PE File:
Hier wird mit Select das erstellte PE-Logfile ausgewählt.
Mit Follow kann man das Logfile schon anzeigen während V4 Control noch
aufzeichnet. Da Windows das File immer in Blöcken beschreibt dauert es
immer eine Weile bis die nächsten Werte angezeigt werden.

· PEC during Measurement:
Hier kann eigenstellt werden ob PEC während der Aufzeichnung aktiviert
war oder nicht. Dies ist notwendig wenn man per ”Touch-Up“ die Tabelle
verfeinern will - siehe Abschnitt 3.

• Data Range:
Hier kann das Logfile ”beschnitten“ werden falls z.B der Stern beim Aufzeichnen
aus dem Such-Fenster gewandert ist.

· First Sample:
Der erste Eintrag im Logfile der verwendet werden soll

· Last Sample:
Der letzte Eintrag im Logfile der verwendet werden soll

• PE Smoothing:
Wurden mehrere Schneckenrad Umdrehungen aufgezeichnet, kann hier eingestellt
werden wie Aspect den Mittelwert bildet.
Außerdem kann die aufgezeichnete Kurve ”geglättet“ werden.

· Method:
Entweder arithmetisches Mittel Average bilden oder Median (falls man ”Auß-
reiser“ drin hat.

Aspect - A Simple PEC Tool 9
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· Width:
Stärke der Glättung um z.B Seeing Einflüsse oder Getriebe ”Rauschen“ zu
unterdrücken

• Fixups:
Hier werden die letzten Feinheiten eigestellt

· Star Dec:
Deklination des Sterns, der zum Aufzeichnen verwendet wurde

· Drift:
War die Montierung nicht sauber eingenordet kann man hier den Drift raus-
rechnen lassen

· Scale:
Mit dem Scale-Faktor kann die Kurve gestreckt oder gestaucht werden.
Hat man z.B. mit 2000mm Brennweite aufgezeichnet aber aus Versehen bei
den Einstellungen in V4 Control 1000mm eingestellt kann man nun die Auf-
zeichnung mit einem Scale Factor von 2 noch retten.
Außerdem kann die Kurve mit einem negativen Wert gespiegelt werden falls
man feststellt, dass sich der PE verdoppelt hat.

· Offset:
Hier kann die Kurve nach oben oder unten verschoben werden. Diese Ein-
stellung dient nur der Visualisierung und hat keinerlei Auswirkung auf die
PEC-Tabelle - es ist also völlig egal was man hier einstellt!

In der Liste unter den Einstellungen werden die Werte aus dem Logfile aufgelistet.

Der dritte Reiter (PEC Table) schließlich ist für das erstellen der PEC-Tabelle zuständig:

Aspect - A Simple PEC Tool 10
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• PEC Table:
Hier werden die Werte der PEC-Tabelle dargestellt. Falls noch keine Tabelle be-
rechnet oder geladen wurde entsprechen die Einträge einer perfekten Nachführung
ganz ohne Fehler!
Unter Firmware wird die verwendete Firmware angezeigt.
Aggressiveness (nur Firmware V4) und PEC Factor werden beim Berechnen einer
PEC Tabelle automatisch von Aspect bestimmt und sollten nur geändert werden
wenn man weiß was man tut!

• File:
Hier kann entweder eine alte Tabelle geladen (Open) oder die neu erstellte gespei-
chert (Save As) werden um sie dann z.B. mit V4 Control (anstelle von Aspect) in
die Steuerung zu laden.

• Littel Foot/MCU:
Hat man schon ein PEC-Training gemacht kann hier mit Get die Tabelle direkt
von der Steuerung in Aspect eingelesen werden.
Mit Put kann die erstellte/geladene Tabelle in die Steuerung gespeichert werden.
Und schließlich kann mit Verify überprüft werden ob die in der Steuerung gespei-
cherte Tabelle mit der in Aspect erstellten/geladenen übereinstimmt.

• Calculate:
Hier werden zuerst die Montierungsparameter Firmware und Anzahl der Schne-
ckenrad Zähne (Worm Wheel Teeth) eingestellt (einfacher über Query dann werden
die Parameter automatisch ausgelesen) und dann mit Calculate PEC from PE die
PEC-Tabelle aus unserem zuvor bearbeiteten PE-Logfile berechnet.
Da in Firmware V4 ein weiterer Faktor dazugekommen ist, kann das durchaus eine
Weile dauern.

• PEC Chart Options:
Hiermit kann die PEC-Tabelle nach oben oder unten verschoben werden. Auch hier
gilt dass diese Einstellung nur der Visualisierung gilt und keinerlei Auswirkung auf
die PEC-Tabelle hat.

Damit hätten wir die linke Seite in Aspect und ihre Funktion grob erklärt.

Die rechte Seite ist wie schon kurz angesprochen für die Visualisierung der Daten zu-
ständig:

• Oberes Diagramm:
Hier wird das Positionsprofil dargestellt.
Die X-Achse stellt die 256 möglichen PEC-Tabellen Einträge dar und auf der Y-
Achse wird der Fehler in Bogensekunden angezeigt. Dieser Graph wird für die
meisten am Aussagekräftigsten sein!

• Mittleres Diagramm:
Hier wird das Geschwindigkeitsprofil angezeigt.

• Unterstes Diagramm:
Hier werden die eigentlichen PEC-Tabellen Einträge dargestellt. Man kann es sich
als Beschleunigungsprofil vorstellen.

Aspect - A Simple PEC Tool 11



2 PEC-Tabelle erstellen

• Chart PE/Chart PEC:
Hier können die einzelnen Graphen ein- und ausgeblendet werden.
RAW sind die Roh-Daten aus unserem PE-Logfile und Processed ist die gemittelte
Kurve. Die ”Glättung“ wird auch bei den Rohdaten dargestellt.
Ideal wäre die ideale PEC-Kurve und Table ist die berechnete PEC-Kurve.

Zu guter Letzt kann in der Menü-Leiste unter Tools ⇒ Log View das Log-File von Aspect
betrachtet werden.
Hier werden alle Aktionen welche man in Aspect macht aufgezeichnet. Dies dient nur
zur Fehleranalyse falls es mal zu einem Programmabsturz kommen sollte.
Desweiteren können unter Tools ⇒ Settings einige Einstellungen verändert werden.
Die Einstellungen bei PEC Table Generation sollten wirklich nur verändert werden wenn
man sich auskennt! Unter normalen Umständen sollte man hier nie etwas ändern müssen.
Wenn man einen sehr gleichmäßigen PE mit geringer Amplitude hat kann man hier die
minimale Aggressiveness runter setzten dadurch steigt die Berechnungszeit zwar stark
an liefert aber ein besseres Ergebnis!
Unter Logfiles kann zum einen der Pfad des Log-Files bestimmt werden und welche
Aktionen geloggt werden.
Die Einstellungen unter Experimental werden für den normalen Aspect-Gebrauch nicht
benötigt und sind zum Teil noch ungetestet!

Aspect - A Simple PEC Tool 12
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2.2.2 Bearbeiten des PE-Logfiles

Nach dem Aspect gestartet wurde stellen wir zuerst Verbindung zur Steuerung her. Dies
ist zwar nicht zwingend erforderlich erleichtert uns aber nachher die Arbeit!
Falls das nicht Möglich sein sollte muss man halt nachher einige Einstellungen von Hand
tätigen.
Also unter MCU ⇒ Serial Port den Com-Port an dem die Steuerung hängt auswählen
und dann auf Settings ⇒ Refresh.

Tip: Schlägt das Fehl sollte man zuerst prüfen ob V4 Control eventuell noch mit
der Steuerung verbunden ist und gegebenen Falls dort die Verbindung trennen.

War die Verbingung erfolgreich, sollte unten links der graue Kreis neben der Com-Port
Nummer grün werden und in den Drop-Down Listen bei Settings die aktuellen Einstel-
lungen der Steuerung erscheinen.

Nun schalten wir auf den zweiten Reiter PE Data um und fangen mit der Bearbeitung
unseres PE-Logfiles an.
Als erstes laden wir unser Logfile über PE Measurement ⇒ Select dann zu dem aufge-
zeichneten Logfile navigieren und auf Open klicken.
Es sollten dann in der Liste unten die Einträge aus unserem Logfile und auf der rechten
Seite der dazugehörige Graph erscheinen. Damit das ganze etwas übersichtlicher wird
blenden wir alle momentan nicht benötigten Graphen aus (unten rechts alle Haken bis
auf RAW entfernen.
Es sollte dann ungefähr so aussehen:

Nun prüfen wir erstmal ob PE Measurement ⇒ PEC during Measurement auf Off (Nor-
mal) gestellt ist die Touchup-Funktion benötigen wir erst später in Abschnitt 3 !
Dann schauen wir den Graphen genau an und prüfen ob wir am Anfang oder Ende ein
paar Messwerte abschneiden müssen (falls z.B. der Stern am Ende der Messung aus dem
Suchfenster gelaufen ist) und stellen das mit Data Range ⇒ First/Last Sample ein - im
hier gezeigten Beispiel war das nicht nötig.

Aspect - A Simple PEC Tool 13
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Dann tätigen wir alle Einstellungen unter Fixups:

• Star Dec:
Hier wird die Deklination des Sterns eingetragen welcher zur Aufzeichnung ver-
wendet wurde.

Wichtig: Wenn in V4 Control die Deklination des Stern schon berücksichtigt
wurde muss hier 0◦ eingestellt werden sonst würde es zu doppelter ”Korrektion“
kommen!

• Drift:
Hiermit kann ein vorhandener Drift rausgerechnet werden. Im Beispiel sieht man
den Drift deutlich, weil die beiden aufgezeichneten Schneckenrad Umdrehungen
versetzt sind!
Entweder man kennt den Drift oder man verstellt den Drift-Wert solange bis die
Kurven möglichst gut aufeinander passen...
Im Beispiel liefert ein Wert von 0,6”/min das beste Resultat.

• Scale:
Hier sollte man im Normalfall nichts verstellen müssen außer man merkt dass
man beim Aufzeichnen die falsche Brennweite eingestellt hat oder falls man später
merkt, dass sich der PE nach dem aufspielen der Tabelle verdoppelt hat (siehe
Seite 10)

• Offset:
Hier kann man nach belieben den Graphen verschieben (diese Einstellung hat kei-
nerlei Einflüsse auf die PEC-Tabelle).
Im Beispiel hab ich hier -8 eingestellt damit der Graph schön in der Mitte ist.

Dann wechseln wir zum Processed Graph (unten rechts das entsprechende Häckchen
setzten) und stellen unter PE Smoothing ein wie wir das Ergebnis mitteln wollen und
ob wir den Graphen noch glätten wollen (Näheres auf Seite 9)
Im Beispiel hab ich Average und Width 2 gewählt.

Nun haben wir eine schöne PE-Kurve und können mit dem Erstellen der Tabelle weiter
machen.
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2.2.3 Berechnen der PEC-Tabelle

Wir schalten also auf den dritten Reiter (PEC Table) um und aktivieren den Ideal und
Table Graphen - wobei der grüne Table Graph noch überall null ist weil wir ja noch
keine Tabelle berechnet haben.
Nun stellen wir bei Calculate die verwendete Firmware und die Anzahl der Schneckenrad
Zähne ein oder klicken auf Query dann passiert das automatisch (falls es nicht klappen
sollte nochmal auf Seite 13 nachlesen).
Ist das erledigt kann endlich mit Calculate PEC from PE die Tabelle berechnet werden
(dies kann unter Umständen schon eine Weile dauern)!
Ist die Berechnung abgeschlossen, werden der PEC-Tabellen Graph, das Geschwindig-
keits- und Beschleunigungsprofil dargestellt und sollte ungefähr so aussehen:

Die Werte Aggressiveness und PEC-Factor werden automatisch von Aspect berechnet
um ein optimales Ergebnis zu erhalten und sollten nur geändert werden wenn man weiß
was man tut!
Nun kann die Tabelle noch gesichert werden (File ⇒ Save As).

2.2.4 Tabelle in die Steuerung laden

Als letzten Schritt muss die erstellte Tabelle nur noch in die Steuerung geladen werden.
Das geht am einfachsten mit Aspect (Littel Foot/MCU ⇒ Put).

Achtung: Falls schon eine Tabelle in der Steuerung gespeichert ist wird sie nun
überschrieben!
Falls man die alte Tabelle sichern will muss man sie vorher entweder mit V4
Control sichern oder aber mit Aspect über Get abspeichern.
Vorher sollte aber die frisch berechnete Tabelle abgespeichert werden da man sie
sonst nochmals neuberechnen lassen muss!

Alternativ kann man die Tabelle aber auch mit V4 Control in die Steuerung laden. Dazu
muss man die Tabelle nur vorher mit Aspect abspeichern.
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3 PEC-Tabelle optimieren (Touchup)

Die erste PEC-Tabelle wird in der Regel nicht optimal sein. Man kann aber eine beste-
hende Tabelle mit Hilfe der sogennanten Touch-Up Funktion optimieren!
Das Vorgehen ist ziemlich identisch mit dem Erstellen einer neuen Tabelle weshalb ich
mich in diesem Abschnitt relativ kurz fassen werde.

Auch hier sind drei Schritte Notwendig:

1. Restfehler aufzeichnen (V4 Control)

2. Erstellen der optimierten Tabelle (Aspect)

3. neue Tabelle in die Steuerung laden (Aspect oder V4 Control)

3.1 Restfehler aufzeichnen

Das Aufzeichnen des Restfehlers läuft analog zum Aufzeichnen des Periodischen Feh-
lers, nur das diesmal die zuvor erstellte PEC-Tabelle aktiviert ist und somit nur der
verbliebene Fehler aufgezeichnet wird.

3.2 Erstellen der optimierten Tabelle

Auch hier geht man analog wie beim erstellen einer Tabelle vor.
Der einzige Unterschied ist, dass diesmal unter PE Measurement die Option Touchup
ausgewählt wird.
Zusätzlich muss die PEC-Tabelle, welche beim Aufzeichnen aktiviert war in Aspect ge-
laden werden.
Dies erledigt man entweder über PEC Table ⇒ File ⇒ Open falls man die Tabelle vorher
abgespeichert hat (was immer zu empfehlen ist) oder alternativ über LittleFoot/MCU
⇒ Get direkt aus der Steuerung laden.

Tip:
Läd man die Tabelle direkt aus der Steuerung kann es nicht passieren dass man
die Falsche Tabelle in Aspect läd!

Im Optimalfall ist der aufgezeichnete Fehler jetzt null - das wird aber nie passieren! Er
sollte aber deutlich zurückgegangen sein. Ist er das nicht sollte man nochmal prüfen ob
man beim Erstellen der ersten Tabelle alles Richtig gemacht hat!

Tip:
Hat sich der Fehler plötzlich verdoppelt sollte man die Tabelle mit einem Scale-
Faktor von -1 nochmals neu berechnen lassen und prüfen ob es nun besser
geworden ist

Im Normalfall hat man jetzt ein Logfile mit einem geringen Restfehler. Mit der Touchup-
Funktion wird dieser Restfehler im Prinzip einfach auf die schon bestehende Tabelle
addiert.
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Im oben behandelten Beispiel lieferte die Messung mit aktiviertem PEC einen ”Restwelle“
(nicht verwirren lassen dass im Screenshot Touch Up nicht ausgewählt ist, das diente
nur zur Darstellung des Restfehlers!):

Wir gehen also wieder so wie beim erstellen der PEC Tabelle vor und erhalten eine
optimierte PEC-Tabelle.

Diese laden wir wieder in die Steuerung und können nochmals den ”Rest-Rest“-Fehler
aufzeichnen lassen - dies kann man solange Wiederholen bis man Zufrieden ist.
Im Beispiel blieb ein Rest-Rest-Fehler von ± 2“ übrig womit man denk ich wirklich
Zufrieden sein kann!
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4 Checkliste

Hier nun noch ein Zusammenfassung der einzelnen Schritte als Checkliste:

4.1 PEC-Tabelle erstellen (Normal)

• V4 Control - PE-Aufzeichnen:

� Montierung sauber einnorden

� Brennweite, Pixelgröße, Log-File Name einstellen

� Stern auswählen

� auf Lock und dann Follow Star klicken

� Kamera Kalibrieren (Calibrate)

� PEC und Intelly Track R© deaktivieren

� Aufzeichnung starten (Strg+L) und min. zwei Perioden aufzeichnen

• Aspect - PE-Logfile bearbeiten:

� (optional) Com-Port einstellen und Verbindung testen

� Logfile laden (eventuell mit Follow)

� PEC Off (Normal) auswählen

� eventuell Tabelle ”beschneiden“

� Fixups einstellen (Dec nur falls beim Aufzeichnen noch nicht berücksichtigt)

� Average/Median auswählen und eventuell Glätten

• Aspect - PEC Tabelle berechnen:

� Firmware und Schneckenradzähne von Hand oder per Query einstellen

� Tabelle berechnen (Calculate)

� (optional) Tabelle abspeichern

� Tabelle mit Put in Steuerung laden

� (alternativ) mit V4 Control
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4.2 PEC-Tabelle optimieren (Touchup)

• V4 Control - PE-Aufzeichnen:

� Montierung sauber einnorden

� Brennweite, Pixelgröße, Log-File Name einstellen

� Stern auswählen

� auf Lock und dann Follow Star klicken

� Kamera Kalibrieren (Calibrate)

� PEC aktivieren und Intelly Track R© deaktivieren

� Aufzeichnung starten (Strg+L) und min. zwei Perioden aufzeichnen

• Aspect - PE-Logfile bearbeiten:

� (optional) Com-Port einstellen und Verbindung testen

� verwendete PEC-Tabelle laden

� Logfile laden (eventuell mit Follow)

� PEC On (Touchup) auswählen

� eventuell Tabelle ”beschneiden“

� Fixups einstellen (Dec nur falls beim Aufzeichnen noch nicht berücksichtigt)

� Average/Median auswählen und eventuell Glätten

• Aspect - PEC Tabelle berechnen:

� Firmware und Schneckenradzähne von Hand oder per Query einstellen

� Tabelle berechnen (Calculate)

� (optional) Tabelle abspeichern

� Tabelle mit Put in Steuerung laden

� (alternativ) mit V4 Control
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5 Was tun wenn es nicht klappt?

Mit Aspect wird ein neues Kapitel in der PEC-Tabellen Erstellung geschrieben - Noch
nie war es so einfach und bequem eine gute PEC-Tabelle zu erstellen!
Trotzdem hängt der Erfolg von so vielen Faktoren ab, dass es oft zu Problemen kom-
men kann! Deshalb versuche ich hier eine Zusammenfassung der häufigsten Fehler und
Probleme zu erstellen.

5.1 Probleme beim Aufzeichnen des PE

• Ich kann Follow Star nicht auswählen!
Es ist Wichtig zu erst eine Verbindung zur Steuerung herzustellen und erst dann
das Webcam-Fenster zu öffnen.

• Ich kann Calibrate nicht auswählen!
Zuerst Follow Star auswählen dann sollte auch Calibrate auswählbar sein.

• Ich erhalte beim Kalibrieren der WebCam immer einen Fehler!
Dann wird vermutlich der Winkel zu groß sein - also Kamera so drehen, dass
der Stern bei RA-Bewegungen waagrecht läuft. Der Maximale Winkel ist auf 15◦

eingestellt. Er kann zwar geändert werden aber dies wird nicht Empfolen!

• Was kann ich machen, dass der Stern nicht andauernd aus dem Such-
fenster wandert?
Zuerst sollte man prüfen ob die Montierung auch wirklich sauber eingenordet ist!
Dann sollte man prüfen ob vielleicht Intelly Track R© noch aktiviert ist.
Ist das überprüft kann man versuchen das Suchfenster zu vergrößern (in RA und
DEC) - siehe Seite 4.

• Ich erhalte zu wenig Messpunkte, weil mein PC nicht genug Leistung
hat!
In diesem Fall sollte man prüfen ob das Suchfenster noch verkleinert werden kann.
Ist dies nicht mehr Möglich hat man nur noch die Möglichkeit einen Brennweiten-
reduzierer zu verwenden oder ein anderes Teleskop mit geringerer Brennweite!

• Ich kann das Logfile nicht finden!
Das Logfile befindet sich immer im Hauptordner von V4 Control - also nochmal
genau nachschauen!
Ist es wirklich nicht vorhanden das nächste mal vielleicht auch wirklich die Auf-
zeichnung starten...

• Meine Aktuelle Messung ist nicht da!
Wurde der Name des Logfiles auch wirklich geändert?
Wenn nicht, wurde die Messung an das Ende der letzten Messung angehängt! In
diesem Fall beleiben nur noch zwei Möglichkeiten:
Entweder man lässt das Logfile in Aspect so beschneiden, dass die erste Messung
nicht berücksichtigt wird, oder man öffnet das Logfile in Excel oder sonst wie und
kopiert die zweite Messung in eine neue Datei - die Zeiten werden ja mitgeloggt!
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5.2 Probleme beim erstellen der PEC-Tabelle

• Aspect kann nicht gestartet werden - irgendwas soll anscheinend fehlen!
Ja das kann gut sein - nochmal auf Seite 3 nachlesen!

• Ich kann keine Verbindung zur Steuerung aufbauen!
Dafür kann es viele Gründe geben - da zum loggen des PE auch eine Verbindung
notwendig war sollte zu erst geprüft werden ob V4 Control noch mit der Steuerung
verbunden ist...

• Ich hab die Follow-Option aktiviert aber es passiert nichst!
Geduld! Windows beschreibt die Datei immer in Blöcken und da dauert es halt ein
wenig...

• Das Logfile enthält unsinnige Werte!
Ist der Stern vielleicht aus dem Suchfenster gewandert? Denn dann kann auch kein
Fehler mehr aufgezeichnet werden!
Wurde die Verbindung zur Steuerung in V4 Control beendet um z.B. in Aspect
Daten zu laden und beim nächsten Aufzeichnen in V4 Control nicht wieder ver-
bunden? Denn dann kann die Schneckenposition nicht mit geloggt werden!

• Mein PE ist auf einmal falschrum!
Dann wurde vermutlich vergessen die WebCam vor der Aufzeichnung zu kalibrie-
ren! Denn dann weiß V4 Control nämlich nicht wo oben und unten ist!

• Mein PE ist auf einmal zu groß/klein!
Ist vor dem Aufzeichnen auch alles richtig eingestellt worden (Brennweite, Pixel-
größe)? Wurde die Webcam kalibriert? Wurde die Deklination des Sterns doppelt
berücksichtigt (also beim Aufzeichnen und in Aspect)? War PEC auch wirklich
deaktiviert?

• Mein PE ist mit aktiviertem PEC größer geworden!
Wenn er sich verdoppelt hat Tabelle noch mal neuberechnen lassen mit Scale Faktor
-1. Ansonsten nochmal checken ob Firmware und Anzahl der Schneckenradzähne
stimmen!

• Ich hab meine PEC Tabelle per Touchup optimiert aber nun ist der
Fehler wieder größer!
Wurde vielleicht die falsche Tabelle fürs Touchup geladen? Oder wurde Ausversehen
Normal statt Touchup eingestellt?

• Wenn ich meine PEC Tabelle mit dem PE vergleiche stimmt es nicht
überein!
Firmware Einstellung muss stimmen! Ansonsten einfach per Offset beide Graphen
in Einklang bringen!
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Hier nochmal die wichtigsten Links:

• Aspect
http://www.woho.de/devel/astro/aspect.html

• V4 Control
http://mcucontrol.dyndns.org/v4/

• MCU-Update
http://eq6.update.rajiva.de/

• Littelfoot
http://littlefoot.rajiva.de/

• Littelfoot Vpower
http://littlefoot-vp.rajiva.de/

• Support Forum
http://forum.rajiva.de/
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